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Setting up the Environment and the NXT
JAVA, and components for programming the LEGO robot have been installed on your classroom PC.  The programming environment is called leJOS NXT.  

Textpad is the program we will use to compile, link and upload JAVA programs to the LEGO robot.  Textpad needs to be setup.
To setup textpad:

1. Open up "Computer"  (double click the [image: image1.jpg]


 icon, on your desktop)

2. Open up the S:\ drive, then open up the Robotics Folder.

3. Double click on the Nxjlink icon.

4. Double click on the Nxjupload icon.

5. Double click on the Nxjlink icon.

(Each of these icons installs commands inside of Textpad which interact with the lego mindstorm robot).

6. Start Textpad (Start, Programs, [image: image2.jpg]B TedtPad



)

7. Verify that the "Tools" command has the correct sub-commands.

a. Click "Tools", look for "Nxjlink, Nxjupload and Nxjc as in the image below:
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b. If they do not appear, exit Textpad and try steps 3 through 5 again.  These steps will not work properly, while Textpad is running.
Writing your first Java Program

LEJOS is a text-based programming language based on the standard Java programming language.

All Java programs start out as plain text files.  The Java compiler turns them into machine language "class" files which are the actual runable programs.  Java programs can be created in any plain text editor (Windows Notepad) but not in Microsoft Word.  We use TextPad, due to it’s ability to interface to the Java compiler, and to the leJOS software.

Create a class named Hello.

1.  Open TextPad.  Type the following text exactly as it is listed.  Notice the “curly” brackets which open on line 3 and close on line 5.
class Hello
{

}

2. Between the curly brackets of the Hello class, insert this code – to create a "main" method for the Hello class.  This is equivalent to the "World My First Method" in ALICE
public static void main(String[] args)
{

}

3. Between the main method, insert this code – stating what the program will do
System.out.println("Hello World!");

4. Check your program, the complete program should now look like this (Note the indents!):
class Hello
{
   public static void main(String[] args)
   {
      System.out.println("Hello World!");
   }

}

Important notes:

· Java is a case-sensitive language.  "System" and "system" mean two different things.

· The file name should always have the “.java” extension and the name should be the same as the class, which has the main method.
5. [image: image127.png]
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Compiling and Running the Program – Using Textpad

To run a program on your computer
1.  Compile the program (checks syntax and creates the .class file) by clicking on “Tools” and selecting “Compile Java”.

2. If the compile was successful, run the program by clicking “Tools”, then selecting “Run Java Application”.
Lesson 2 – Download a Program to the NXT
Your robot is ready to go! All that’s left is for you to tell it what to do by sending it a program. A program is a set of commands that tell the robot what to do and how to react to its environment. Once written, a program must be transferred (“downloaded”) to the robot before it can be run.

You will need:

1. Your NXT (Robot)

2. A computer with leJOS NXJ installed

3. TextPad, configured with the NXJ commands

4. A USB connector cable

1. Start Textpad

2. Save with Java file type - so Textpad knows the syntax to use
a. In TextPad, click File, Save As.

b. Navigate to your Z: drive

c. [image: image144.emf][image: image145.emf]In Filename box type "XXTurnWheel"  
d. In the "Save As Type" box, 
select java.

3. [image: image146.emf]Type the program EXACTLY as listed below.

	1
	import lejos.nxt.*;

	2
	

	3
	class XXTurnWheel {

	4
	{   public static void main(String [] args) throws InterruptedException

	5

6

7
	    { 
      Motor.C.setSpeed(900);

      Motor.C.forward();

	8
	      Thread.sleep(3000);

	9
	      Motor.C.stop();

	10
	    }

	11
	}


4. Compile the program (checks for syntax and creates a .class file)

a. In Textpad, click, Tools, "Nxjc"
[image: image147.emf]
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Definition:  Compile – translate a program from a programming language humans understand (example:  Java), into a lower level language the computer understands and can quickly run.  The original program is usually called the source, the output is called the object.  With Java, the object module is named the same as the program, but has ".class" as the suffix.

Example:
Source:  XXTurnWheel.java

Object:  XXTurnWheel.class

Note:  The only code compiled is the Java program you had displayed when you clicked on the "Tools", "Nxjc" command.  References to other Java routines are stored as jumps to unresolved addresses.


5. Create a module to be downloaded to your NXT Robot (called a load module).

a. In Textpad, click on XXTurnWheel.java, to make sure you are currently viewing the program you want to link.

b. Click, Tools, Nxjlink.
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[image: image152.emf]
A lot of text output will be displayed… if the "Link" worked successfully, the last line displayed should be:  Tool completed successfully
Definition:  Link – Link is a program which builds a module which can be run by the robot.  It starts with the ".class" file created by the compiler.  It determines all the other Java class files that need to be available, based on the unresolved address jumps stored in the ".class" file.  Some of the routines called by your ".class" file will also call other ".class" files from the standard Java library.  The "Link" program pulls together all of the files needed and creates a file with a suffix of ".nxj".  

Example:
Source:  XXTurnWheel.java



Object:  XXTurnWheel.class



Linked:  XXTurnWheel.nxj

6. Upload the program to the NXT Robot
a. Turn the NXT robot on by pressing the “orange” button.
b. Connect the USB cable from the robot to your computer

c. In Textpad, click on XXTurnWheel.java, to make sure you are currently viewing the program you want to download.

d. Click, Tools, Nxjupload

[image: image153.emf]
[image: image154.png]xxLineFollow2 java




[image: image155.emf]
e. The NXT should beep, acknowledging the action
Definition:  Upload – The program is physically copied from your computer, via the USB cable and stored on the NXT robot.

If you get an error, make sure that the robot is turned on and plugged in to the computer with the USB cable, then try again.

7. Run the program on the NXT Robot
a. The cable can remain connected, or you can disconnect.

b. The NXT display should be similar to the following:

>
Run Default


Files


Bluetooth


Sound


System


Version

c. Click the right arrow button, to move the selector down to "Files".

d. Press the “orange” “Enter” button to select.

e. Press the right arrow button, if necessary, to move the selection down to “XXTurnWheel”.

f. Press the “orange” “Enter” button to select “XXTurnWheel”.

g. Press the “orange” “Enter” button one more time to run the program.

h. You can switch the NXT off at any time, including when a program is running, by pressing the orange and dark gray buttons (ENTER + ESCAPE) together.To switch it back on just press the orange button. The leJOS NXJ start-up menu will be displayed. 

i. If your NXT freezes at any time, remove and re-insert a battery.
The program we just downloaded told the robot to run one of the motors for three seconds. This causes the robot to move in a circle or perform a pivot turn.
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Thinking about Programming Programmer & Machine (cont.)
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Let’s take a closer look at this last robot. How does it do that? How does it know to do that?
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Creating a successful robot takes a team effort between humans and machines.
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Role of the Programmer

The human is responsible for

identifying the task, planning out a solution, and then explaining to the robot what it needs to do to reach the goal.




	Thinking about Programming Programmer & Machine (cont.)

End of Section

The human who writes the program is called the programmer. The programmer’s job, therefore, is to identify the problem that the robot must solve, to create a plan to solve it, and to turn that plan into a program that the robot can understand. The robot will then run the program, and perform the task.

Finally, take note: the robot only follows the program, it does not think for itself. Just as it can be no stronger than it is built, the robot can be no smarter than the program that the human programmer gave it. You, as programmer, will be responsible for planning and describing to the robot exactly what it needs to do to accomplish its task.







	Thinking about Programming Planning & Behaviors (cont.)

End of Section

By starting with a very large solution behavior, and breaking it down into smaller and smaller sub-behaviors, you have a logical way to figure out what the robot needs to do in order to accomplish its task.

By recording the behaviors in English, you have taken the first steps toward good pseudocoding practice, allowing you to easily review the behaviors and their organization as you prepare to translate them to program code.

The only step remaining is to translate your behaviors from English pseudocode to leJOS programming language.


Moving Forward - Code Dissection
Now that you understand the steps needed to download a program, which you learned through downloading a sample program, let’s take a step back and figure out what all of this “code” is really doing.
Here on the main screen we have several lines of code. Let’s walk through what each of these commands “does”.

	1
	import lejos.nxt.*;




	2
	





	3
	class XXTurnWheel 




	4
	{   public static void main(String [] args) throws InterruptedException

	5

6

7
	    { 

      Motor.C.setSpeed(900);

      Motor.C.forward();

	8
	      Thread.sleep(3000);

	9
	      Motor.C.stop();

	10
	    }

	11
	}






	4
	{   public static void main(String [] args) throws InterruptedException

	5

6

7
	    { 

      Motor.C.setSpeed(900);

      Motor.C.forward();

	8
	      Thread.sleep(3000);

	9
	      Motor.C.stop();

	10
	    }

	11
	}


public static void main(String [] args)

throws InterruptedException

	6

7
	      Motor.C.setSpeed(900);

      Motor.C.forward();

	8
	      Thread.sleep(3000);

	9
	      Motor.C.stop();


As you know, the code currently tells the robot to move in a circle. More literally, it tells the robot to move “Motor C” forward for 3 seconds. Moving only one motor, or wheel, will make your robot go in circles. The details of each command are as follows:
	6
	      Motor.C.setSpeed(900);


The Motor.C.setSpeed method sets the motor speed in the number of degrees of rotation in 1 second.  The maximum possible value is 900.  

	7
	      Motor.C.forward();


The Motor.C.forward() method, tells the robot to start the motor, plugged into plug C, to run in the forward direction.   Since we previously set the speed at 900 dps, the motor will turn at that speed.

Note:  every command in leJOS Java must end with a semicolon, just as every English statement must end with a period.
	8
	      Thread.sleep(3000);


The Thread.sleep method tells the robot to wait, for the given time in milliseconds. The number within the parenthesis is the number of milliseconds that you want the robot to wait. 3000 milliseconds is equal to 3 seconds, so the robot moves its Motor C in a forward direction, at 900 dps. for 3 seconds.

Moving Forward – Modify the Code

1. Before making any changes, save the program with a new name. Go to “File”, “Save As”, and rename this program to “XXLabyrinth”.  Instead of XX, use your initials.  
Example:  Tony Tiger would name his program "TTLabyrinth".
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	6

7

8

	      Motor.C.setSpeed(900);

      Motor.C.forward();


	9

10

	      Thread.sleep(3000);


	11

12

	      Motor.C.stop();



	

	

	


2. In order to make the robot go forward, you’ll want both motor C and motor B to run forward, at the same speed. The methods  Motor.C.setSpeed and Motor.C.forward made Motor C move forward.  Add methods that are exactly the same, but address Motor B instead.
	6

7

8
	      Motor.C.setSpeed(900);

      Motor.B.setSpeed(900);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(3000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();


4. Make sure your robot is on and that the robot is plugged in with the USB cable,  then go to the tools menu: 











[image: image7.png]Moving Forward code Dissection (cont)
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Moving Forward – Timing Lesson
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Thread.sleep(3000)

	6

7

8
	      Motor.C.setSpeed(900);

      Motor.B.setSpeed(900);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(2000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();


2. Compile, Link, and Upload the program, then test to see the change in the robot's behavior. 
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Speed and Direction – Motor Power
In this lesson, you will modify the existing program to make your robot move at a slower speed. This should result in more consistent movement.
Moving at slower speeds can help your robot to be more consistent. All you need to do is alter the motor commands to turn the motors on with a power level lower than 900 degrees per second (100%).

1. Change the power levels in your setSpeed methods to move at half speed.

	6

7

8
	      Motor.C.setSpeed(450);

      Motor.B.setSpeed(450);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(2000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();


3. Save your program.  Make sure your robot is on and that the robot is plugged in with the USB cable,  then go to the tools menu: 










Checkpoint. The numeric value assigned to each motor in the setSpeed commands represents the degrees per second that the motors will turn. So far, we’ve changed them from full speed to half.  Since your robot is traveling slower, it will now need to travel longer to go the same distance.
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3. Since the power has been halved, try doubling the time.





	6

7

8
	      Motor.C.setSpeed(450);

      Motor.B.setSpeed(450);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(4000);

	11

12
	      Motor.C.stop();
      Motor.B.stop();


4. Compile, Link, and Upload the program, then test to see the change in the robot's behavior. 
[image: image11.emf]
Speed and Direction – Turn and Reverse
In this lesson, you will learn how to make the robot turn and back up using different combinations of motor powers, and how to perform multiple actions in a sequence.
Setting both motors to half power makes the robot go slower. What do other combinations of motor powers do?
2. You might think that negative numbers make the motor spin in reverse.

	6

7

8
	      Motor.C.setSpeed(-900);

      Motor.B.setSpeed(-900);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(3000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();


5. Save your program.  Make sure your robot is on and that the robot is plugged in with the USB cable,  then go to the tools menu: 










As you noticed, setting the motor speed to a negative number did not work  Instead we have to change the “forward” method to a “backward” method.

	6

7

8
	      Motor.C.setSpeed(900);

      Motor.B.setSpeed(900);

      Motor.C.backward();

	9

10
	      Motor.B.backward();

      Thread.sleep(3000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();


3. Compile, Link, and Upload the program, then test to see the change in the robot's behavior. 

[image: image12.emf]
2. A motor power of 0 makes the robot stop.

	6

7

8
	      Motor.C.setSpeed(0);

      Motor.B.setSpeed(0);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(3000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();


2a.  Compile, Link, and Upload the program, then test to see the change in the robot's behavior. 

[image: image13.emf]
3  Giving different powers to the two motors causes the robot to turn in various ways.  

	6

7

8
	      Motor.C.setSpeed(900);

      Motor.B.setSpeed(900);

      Motor.C.forward();

	9

10
	      Motor.B.backward();

      Thread.sleep(3000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();


2a.  Compile, Link, and Upload the program, then test to see the change in the robot's behavior. 

[image: image14.emf]
4.  Making one wheel move while the other remains stationary causes the robot to “swing turn” with the stationary wheel acting as a pivot.

	6

7

8
	      Motor.C.setSpeed(900);

      Motor.B.setSpeed(0);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(3000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();


2a.  Compile, Link, and Upload the program, then test to see the change in the robot's behavior. 

[image: image15.emf]
Checkpoint

The following table shows the different types of movement that result from various combinations of motor powers. Remember, these commands only set the motor powers.  You still need to run the forward methods, thread.sleep and stop methods to tell the robot to start the motors and how long to let them run before stopping them.
	Motor Commands
	Resulting Movement

	Motor.C.setSpeed(900);

Motor.B.setSpeed(900);

Motor.C.forward();

Motor.B.forward();
	
forward
Quickly

	Motor.C.setSpeed(450);

Motor.B.setSpeed(450);

Motor.C.forward();

Motor.B.forward();
	
forward
slowly

	Motor.C.setSpeed(900);

Motor.B.setSpeed(900); Motor.C.backward();

Motor.B.backward();
	
backwards quickly

	Motor.C.setSpeed(0);

Motor.B.setSpeed(0);

Motor.C.forward();

Motor.B.forward();
	
stop,
lock motors

	Motor.C.setSpeed(900);

Motor.B.setSpeed(900);

Motor.C.forward();

Motor.B.backward();
	
pivot
turn

	Motor.C.setSpeed(900);

Motor.B.setSpeed(0); Motor.C.forward();

Motor.B.forward();
	
swing
turn


6.  Finally, the robot will need to be able to perform multiple actions in a sequence. Commands in lejos Java are run in order from top to bottom, so to have the robot perform one behavior after another, simply add the second one below the first in the code.

	6

7

8
	      Motor.C.setSpeed(450);

      Motor.B.setSpeed(450);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(4000);

	11

12

13
	      Motor.C.stop();

      Motor.B.stop();



	14

15

16
	      Motor.C.setSpeed(450);

      Motor.B.setSpeed(450);

      Motor.C.backward();

	17

18
	      Motor.B.forward();

      Thread.sleep(800);

	19

20
	      Motor.C.stop();

      Motor.B.stop();




6a.  Compile, Link, and Upload the program, then test to see the change in the robot's behavior. 

[image: image16.png]-
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JAVA Creating your own methods
The main method, like the "World My First Method" in ALICE, should be simple, and straight-forward.  Putting several robot behaviors into the main method will cause it to quickly grow too large.

The solution is to write our own methods.  When moving the robot, you may have noticed that the speed, and length of time are the primary portions of the code which change, when we want to alter the distance, or direction we want our robot to travel.

	1
	import lejos.nxt.*;

	2
	

	3
	class TTLabryinth

	4

5
	{   public static void main(String [] args) throws Interrupted Exception
    {

	6

7

8
	      Motor.C.setSpeed(450);

      Motor.B.setSpeed(450);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(4000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();

	10
	    }

	11

12
	
}





Let’s write a method called “moveRobot”.  It will need to know speed for motor B (an integer number), speed for motor C (integer) and the length of time (integer) we want the motors to run.


We will start the code on line 11:

	11
	    public static void moveRobot(int speedB, int speedC, int runtime)




	12
	             throws InterruptedException







	13
	     {

	14

15

16
	         Motor.C.setSpeed(speedC);

         Motor.B.setSpeed(speedB);

         Motor.C.forward();

	17

18
	         Motor.B.forward();

         Thread.sleep(runtime);

	19

20
	         Motor.C.stop();

         Motor.B.stop();





	21
	      }


Now, in the main method, let's call our newly written method.

	1
	import lejos.nxt.*;

	2
	

	3
	class TTLabryinth {

	4

5
	{   public static void main(String [] args) throws InterruptedException

    {

	6

7

8
	      Motor.C.setSpeed(450);

      Motor.B.setSpeed(450);

      Motor.C.forward();

	9

10
	      Motor.B.forward();

      Thread.sleep(4000);

	11

12
	      Motor.C.stop();

      Motor.B.stop();

	10
	    }


	1
	import lejos.nxt.*;

	2
	

	3
	class TTLabryinth {

	4
	{   public static void main(String [] args) throws Interrupted Exception

	6

7

8
	    {

      moveRobot(450, 450, 4000);

      moveRobot(450,-450, 800);

	9

10
	      

      

	11

12
	      

      

	10
	    }


Our finished program is on the next page:

	1
	import lejos.nxt.*;

	2
	

	3
	class TTLabryinth {

	4
	{   public static void main(String [] args) throws InterruptedException

	6

7

8
	    { 

      moveRobot(450, 450, 4000);  // go straight 4 seconds

      moveRobot(450,-450, 800);   // pivot turn .8 seconds

	9
	    }

	10

11
	    public static void moveRobot(int speedB, int speedC, int runtime)

	12
	             throws Interrupted Exception

	13
	    {

	14

15

16
	        Motor.C.setSpeed(speedC);

        Motor.B.setSpeed(speedB);

        Motor.C.forward();

	17

18
	        Motor.B.forward();

        Thread.sleep(runtime);

	19

20
	        Motor.C.stop();

        Motor.B.stop();

	21

22
	     }

}


Compile, Link, and Upload the program, then test to see the robot's behavior. 
It did not work…the second turn was a swing turn (motor C stopped) we cannot use negative numbers for speed.  Let’s modify the method to handle negative speeds (backwards).

JAVA Creating your own methods – absolute value function
The first problem we have is that we cannot pass a negative number to the “setSpeed” method.  We can use a JAVA function to find the absolute value of a number.  This function is:  Math.abs, we pass to it any number and it returns the absolute value of a number.  Example:  if we pass it  -720, it will return 720 (positive).  If we send a value of 200 to it, the returned value will be the same, positive 200.
	1
	import lejos.nxt.*;

	2
	

	3
	class TTLabryinth {

	4
	{   public static void main(String [] args) throws InterruptedException

	6

7

8
	    { 

      moveRobot(450, 450, 4000);  // go straight 4 seconds

      moveRobot(450,-450, 800);   // pivot turn .8 seconds

	9
	    }

	10

11
	    public static void moveRobot(int speedB, int speedC, int runtime)

	12
	             throws Interrupted Exception

	13
	    {

	14

15

16
	        Motor.C.setSpeed(Math.abs(speedC));

        Motor.B.setSpeed(Math.abs(speedB));

        Motor.C.forward();

	17

18
	        Motor.B.forward();

        Thread.sleep(runtime);

	19

20
	        Motor.C.stop();

        Motor.B.stop();

	21

22
	     }

}


JAVA Creating your own methods – if statement
The second problem we have is that if the speed is negative, we want to move the motor in the backwards direction, instead of the forward direction.  To accomplish this, we’ll add an “if” statement.

IF SYNTAX:

if (<condition>)
  { statements to execute when the condition is true }
else
  { statements to execute when the condition is not true}
<condition> can be any expression that evaluates to true, or false.  Usually this is referred to as a Boolean expression.  It can also be a Boolean variable.
The relational operators:


<     “less than”


>     “greater than”


==   “equal to --- note that we use two equal signs, to make this different than “=” which is used to assign a value to a variable.

Line 16 of our program needs to be changed.
	16
	        Motor.C.forward();


We only want the motor to move forward, if the speed  for motor C is a positive number, otherwise, we want to the motor to move backwards.  Let’s add an “if” statement.

	16

17

18

19
	        if (speedC > 0)

           { Motor.C.forward(); }

        else

           { Motor.C.backward(); }




We need to make the same changes for Motor B

	20
21
22

23
	        if (speedB > 0)

           { Motor.B.forward(); }

        else

           { Motor.B.backward(); }


Our completed TTLabryinth program with a revised moveRobot method
	1
	import lejos.nxt.*;

	2
	

	3
	class TTLabryinth {

	4
	{   public static void main(String [] args) throws InterruptedException

	6

7

8
	    { 

      moveRobot(450, 450, 4000);  // go straight 4 seconds

      moveRobot(450,-450, 800);   // pivot turn .8 seconds

	9
	    }

	10

11
	    public static void moveRobot(int speedB, int speedC, int runtime)

	12
	             throws Interrupted Exception

	13
	    {

	14

15

16

17

18

19
	        Motor.C.setSpeed(Math.abs(speedC));

        Motor.B.setSpeed(Math.abs(speedB));

        if (speedC > 0)

          {Motor.C.forward();}
        else

          {Motor.C.backward();}

	20
21
22

23

24
	        if (speedB > 0)

          {Motor.B.forward();}

        else

          {Motor.B.backward();}
        Thread.sleep(runtime);

	25
26
	        Motor.C.stop();

        Motor.B.stop();

	27
28
	     }

}


 Compile, Link, and Upload the program, then test to ensure this program works.

 Add more lines like 7, and 8, to try a variety of maneuvers. 

DETERMINING MOTOR TIME BASED ON DISTANCE

When we want to move our robot, it is inconvenient to always have to guess how many seconds we need to have the motors on.  Instead, it would be helpful if we could calculate the amount of time to turn on the motors, based on the distance we want the robot to travel.

1.  We know that the basic formula for distance and time is:

[image: image17.png]d=r=xt




d = distance     

r = rate of speed   

t = time
For example, if a car were travelling 60 mph, for 2 hours, it would travel 120 miles.
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Solving this equation for time, 

[image: image19.png]A




2.  
Rearranging the above equation, we can come up with a way to determine time, based on the distance we want to travel:
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 =
3.  
Regarding the rate of speed:  initially we know the speed the motor is turning, in degrees per second (dps).  We need to translate this into the speed of the robot in cm per second.

3a.
First change degrees per second into revolutions per second:

degrees per second [image: image23.png]— dps degrees | 1revolution _ revolutions

cecond | 360 degress  secomd




In other words, dividing the dps by 360 gives us the number of revolutions the wheel turns in 1 second.  

Example:  A wheel turning 720 degrees per second 

= 720/360 revolutions per second 

= 2 rps

[image: image24.png]dps degrees per second

7 rps (revolutions per second)




3b.  Now determine how the speed the robot will travel (rate), based on revolutions per second.  Distance travelled in one revolution equals the circumference of the wheel:

[image: image25.png]1 revolution = 1 circumference




We know that the circumference of a circle (wheel) equals [image: image27.png] times the diameter
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4.  
Putting all of this together, if we know the distance (d) we want our robot to travel, we know the motor speed, in degrees per second (dps) and the diameter (diam) of the wheel, we should be able to calculate the length of time we want the motors to run.

4a.  From step 2, we know the formula for time, based on distance (d) 
and rate of speed (r).
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4b.  From 3b, substitute for "r", the rate of speed calculation:
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4c.  Substituting from 3a, [image: image33.png]2|8




[image: image34.png]



[image: image35.png]t (seconds) = u
dps

ZL% s 7+ diam




4d.  Multiple by 1, or  [image: image37.png]& | &



 to factor the 360 out of the denominator
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4e.  Now we have solved for time (t) knowing distance (d) we want to travel, the motor speed (dps) and the wheel size (diam).
5.  Everything we've done up to this point assumes that every time the motor turns 1 revolution, the wheels turns 1 revolution.  If the gears connected to the motor are a different size than the gears connected to the wheels, the wheel speed will be different than the motor speed.  

5a.  Example 1, if the motor gear has 100 teeth, and the wheel gear has 50 teeth, the wheel turns 2 revolutions to every 1 revolution of the motor 

gear ratio [image: image40.png]


.

5b.  Example 2, If the motor gear has 33 teeth and the wheel gear has 66 teeth, the wheels will turn ½ a revolution every time the motor turns 1

gear ratio [image: image42.png]


.

6.  
We need to modify our formula to include this gear ratio (GR) multiplier, as a multiplier of the revolutions, or the dps.
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7.  
As a final step, we need to multiply this result by 1,000, to determine the number of MilliSeconds we want to turn the motor on, to cover the desired distance.
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Now to put this into Java code.
Start with some simple Java code that moves the robot forward:

	1
	import lejos.nxt.*;

	2
	class MoveForward 

	3
	{

	4
	
public static void main(String [] args) 

	5
	
  throws InterruptedException

	6
	
{

	7
	

moveRobot (900,900,1000);

	8
	
}

	9
	

	10
	
public static void moveRobot (int speedB, int speedC,
          int runtime) 

	11
	
  throws InterruptedException 

	12
	
{

	13
	

Motor.C.setSpeed(speedC);

	14
	

Motor.B.setSpeed(speedB);

	15
	

Motor.C.forward();

	16
	

Motor.B.forward();

	17
	

Thread.sleep(runtime);

	18
	

Motor.C.stop();

	19
	

Motor.B.stop();

	20
	
}

	21
	}


Here are the statements we'll add, to declare constants:




	private static final double DIAMETER        = 5.55;

	private static final double MTRtoWHEELratio = 1/1;

private static final double PI              = 3.1415926;





	9
	

	10

11
	
public static void goDistance 
                (double  cmDistance, int dpsSpeed) 

	12
	
  throws InterruptedException 

	13
	
{








	14
	

int msTime = (int)((( cmDistance * 360 ) /

	15
	

(dpsSpeed * MTRtoWHEELratio * PI * DIAMETER)) * 1000);







	16
	

moveRobot (dpsSpeed, dpsSpeed, msTime);

	21
	
}

	22
	}


Finished Program:
	1
	import lejos.nxt.*;

	2

3
	class MoveForward 

{

	4
	     private static final double DIAMETER        = 5.55;

	5

6

7
	     private static final double MTRtoWHEELratio = 1/1;

     private static final double PI              = 3.1415926;



	8
	
public static void main(String [] args) 

	9

10
	
  throws InterruptedException

     {

	11
	

goDistance (120,450); // go straight 120cm, 900dps

	12
	
}

	13

14
	
public static void goDistance 
                (double  cmDistance, int dpsSpeed) 

	15

16

17
	
  throws InterruptedException 

     {

        //  calculate time needed to travel desired distance

	18
	

int msTime = (int)((( cmDistance * 360 ) /

	19

20
	

(dpsSpeed * MTRtoWHEELratio * PI * DIAMETER)) * 1000);

        //  now move the robot that time, for desired speed

	21
	

moveRobot (dpsSpeed, dpsSpeed, msTime);

	22
	
}

	23
	

	24

25
	
public static void moveRobot (int speedB, int speedC,
          int runtime) 

	26
	
  throws InterruptedException 

	27
	
{

	28
	

Motor.C.setSpeed(speedC);

	29
	

Motor.B.setSpeed(speedB);

	30
	

Motor.C.forward();

	31
	

Motor.B.forward();

	32
	

Thread.sleep(runtime);

	33
	

Motor.C.stop();

	34
	

Motor.B.stop();

	35
	
}

	36
	}


SWING TURNS:

A turn where one wheel moves and the other wheel is stationary is called a “swing turn”.  The robot’s moving wheel moves in a circle, where the inner wheel is the center of the circle and the outer wheel travels around the circumference.  The radius of this "Traced Circle" is the distance between the wheels.

Our challenge is to determine the amount of time the moving wheel needs to travel, to turn the robot a desired angle.

First, let’s calculate the time needed to turn the robot all the way around (360 degrees).  The outer wheel will need to travel the entire circumference of the “traced circle”.  The circumference of the traced circle is based on it’s radius (R):
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To travel this distance, use the time equation, above.

Time to travel Traced Circle (TCt)  [image: image47.png]TCcx360
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If we wanted the robot to turn only half way around (180 degrees), we would only need to drive the motor for half of that time.

Time to travel 180 degrees = [image: image49.png]TC
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Generalizing…  the time to travel any turn N = [image: image55.png]


t
The complete formula (R=Robot Wheelbase = Radius of Traced Circle, dps = motor speed in degrees per second, GR = Gear Ratio, ratio of Motor Gear to Wheel Gear, diam = Wheel Diameter, N = desired turn angle:

Swing Turn time:  [image: image57.png]T*2+R*360
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As a final step, we need to multiply this result by 1,000, to determine the number of MilliSeconds we want to turn the motor on, to cover the desired distance.

Swing Turn time:  [image: image63.png]1000%2*R+N
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Add a global constant named WHEELBASE to your program, which is the distance between the robots two drive wheels.
Write a new method named swingTurnLeft, which accepts two parameters:


1.  double turnAngle  // angle of desired left turn


2.  integer dpsSpeed

This method should calculate the amount of time to rotate the one wheel, then call your moveRobot method to turn the robot, passing it the appropriate time, and motor speeds.

Write another new method named swingTurnRight, which accepts two parameters:


1.  double turnAngle  // angle of desired right turn


2.  integer dpsSpeed

This method should calculate the amount of time to rotate the one wheel, then call your moveRobot method to turn the robot, passing it the appropriate time, and motor speeds.
PIVOT TURNS:

A pivot turn is turn where one wheel turns forward and the other wheel turns backward.  The DIAMETER of the circle the robot makes is the distance from one drive wheel to another.  The formula is exactly the same as the SWING TURN, except we drop the “2” in the numerator.

The complete formula (R=Robot Wheelbase = Radius of Traced Circle, dps = motor speed in degrees per second, GR = Gear Ratio, ratio of Motor Gear to Wheel Gear, diam = Wheel Diameter, N = desired turn angle:

Pivot Turn time:  [image: image65.png]T*R*360
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As a final step, we need to multiply this result by 1,000, to determine the number of MilliSeconds we want to turn the motor on, to cover the desired distance.

Pivot Turn time:  [image: image71.png]1000«R*N
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Write a new method named pivotTurnLeft, which accepts two parameters:


1.  double turnAngle  // angle of desired left turn


2.  integer dpsSpeed

This method should calculate the amount of time to rotate the wheels, then call your moveRobot method to turn the robot, passing it the appropriate time, and motor speeds.

Write another new method named pivotTurnRight, which accepts two parameters:


1.  double turnAngle  // angle of desired right turn


2.  integer dpsSpeed

This method should calculate the amount of time to rotate the one wheel, then call your moveRobot method to turn the robot, passing it the appropriate time, and motor speeds.

Wall Detection Touch vs. Timing
[image: image72.emf]
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2. Instructions for adding a touch sensor:

a. Start the Program "Robotics Engineering Vol. I", from the Robotics Engineering start menu folder.

b. Click the "Reference" Button at the top.

c. Click "Building Instructions" on the left, under "Reference".

d. Click "Touch Bumper".

e. Follow the instructions for installing the sensor by stepping through the numbered steps, at the top of the page. 

Now let's write some code to use the touch sensor.

1. Open Textpad

2. Write a new program, naming it xxTouch, where xx is your initials.

	1
	import lejos.nxt.*;

	2
	

	3
	class xxTouch
{public static void main(String [] args) throws InterruptedException







	4

5

6
	 {final TouchSensor touch = new TouchSensor(SensorPort.S1);





	7

7

8
	      while(touch. isPressed () == false)

        {

          Motor.C.setSpeed(900);

          Motor.B.setSpeed(900);

          Motor.C.forward();

          Motor.B.forward();

	9

13

14
	        }

      Motor.C.backward();

      Motor.B.backward();

	15

16

17
	      Thread.sleep (1000);

      Motor.C.stop();

      Motor.B.stop();

	18
	    }

	19

20
	}


[image: image74.emf]
Wall Detection – The while() Loop
[image: image75.png]Your robot’s ability to sense and respond to touch revolves around a structure in the program

called a while() loop. The while() loop in this program uses the Touch Sensor feedback to decide
whether the robot should continue on its current course, or back up and turn.

In this lesson, you will learn what a while() loop is and how it works.

Below is the code for the sample program’s while() loop. Reading this statement out loud tells you
pretty much exactly what it does:

“While the sensor value of the Touch Sensor is equal to zero, run motors C and B at 100% power.”
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[image: image77.png]The decision-making nature of the while() loop may not be apparent at first, but making
decisions that control the flow of the program is actually the while() loop’s main purpose. The

while() loop above instructs the program to use the Touch Sensor’s status to decide how long to
keep the motors running.

‘When the program reaches most commands, it runs them, and then moves on. When the
program reaches the while() loop, however, it steps “inside” the loop, and stays there as long as
the while() loop decides that it should. The loop also specifies a set of commands that the robot
will repeat over and over as long as the program remains inside the loop.

The programmer specifies in advance under what conditions the program should remain in the
loop, and what commands the robot should repeat while inside the loop.

The while() loop therefore has three parts, in order:

* The word “while”

* The condition enclosed in parentheses “()”

* A group of commands enclosed in curly braces “{}"
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Wall Detection – A Sonic Sojourn
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1. Open the xxTouch program you wrote for the previous section.

2. Checkpoint.  The program should look like the one below.


	1
	import lejos.nxt.*;

	2
	class xxTouch

	3
	{public static void main(String [] args) throws InterruptedException

	4
	    {final TouchSensor touch = new TouchSensor(SensorPort.S1);

	5

6

7

8

9

10
	      while(touch. isPressed () == false)

        {

          Motor.C.setSpeed(900);

          Motor.B.setSpeed(900);

          Motor.C.forward();

          Motor.B.forward();

	11

12

13
	        }

      Motor.C.backward();

      Motor.B.backward();

	14

15

16
	      Thread.sleep (1000);

      Motor.C.stop();

      Motor.B.stop();

	17
	    }

	18
	}


3. rename the class to xxSonar and save the program as xxSonar.java (where xx is your initials).

	1
	import lejos.nxt.*;

	2
	class xxSonar

	3


	{public static void main(String [] args) throws InterruptedException

  {

	4


	
    UltrasonicSensor sonic = new UltrasonicSensor(SensorPort.S1);

	5

6

7

8

9

10
	      while(touch. isPressed () == false)

        {

          Motor.C.setSpeed(900);

          Motor.B.setSpeed(900);

          Motor.C.forward();

          Motor.B.forward();

	11

12

13
	        }

      Motor.C.backward();

      Motor.B.backward();

	14

15

16
	      Thread.sleep (1000);

      Motor.C.stop();

      Motor.B.stop();

	17
	   }

	18
	}



	1
	import lejos.nxt.*;

	2
	class xxSonar

	3
	{public static void main(String [] args) throws InterruptedException

	4
	  {UltrasonicSensor sonic = new UltrasonicSensor(SensorPort.S1);

	5

6

7

8

9

10
	
      while(touch.isPressed () == false)

        {

          Motor.C.setSpeed(900);

          Motor.B.setSpeed(900);

          Motor.C.forward();

          Motor.B.forward();

	11

12

13
	        }

      Motor.C.backward();

      Motor.B.backward();

	14

15

16
	      Thread.sleep (1000);

      Motor.C.stop();

      Motor.B.stop();

	17
	    }

	18
	}


The program uses the while() loop to check a certain (condition) to see whether it should keep looping or not.  The (condition) right now is satisfied as long as the touch.isPressed method returns a value of false.  The robot keeps running as long as this is true.

But now we're using the Ultrasonic Sensor.  Having the (condition) look for a true / false value no longer makes sense, because the Ultrasonic Sensor can report a large range of values, not just true or false (zero or one).  Remember, the Ultrasonic Sensor measures distance.  It gives you a number that indicates the number of centimeters to the nearest detectable object in front of the sensor.  It could be 1 or 250, or anything in between.

The while() loop, however, doesn't want 250 different values, it just wants to make one decision:  continue looping or go on to the next section of the program.  The task is to get the robot to stop around 25 cm away from the obstacle.  Ask yourself when the robot needs to run, and when it needs to stop.  "The robot should run while…"

We'd like the robot to move forward while it is more than 25 cm away from the box, that is, while the distance to the box is greater than 25 (centimeters).  Once the robot gets closer than 25 cm, it should stop and move on to the next part of the program. So, let's try that. 

5.  Change the program.

	1
	import lejos.nxt.*;

	2
	class xxSonar

	3
	{public static void main(String [] args) throws InterruptedException

	4
	  {UltrasonicSensor sonic = new UltrasonicSensor(SensorPort.S1);

	5

6

7

8

9

10
	
      while(sonic.getDistance() > 25)

        {

          Motor.C.setSpeed(900);

          Motor.B.setSpeed(900);

          Motor.C.forward();

          Motor.B.forward();

	11

12

13
	        }

      Motor.C.backward();

      Motor.B.backward();

	14

15

16
	      Thread.sleep (1000);

      Motor.C.stop();

      Motor.B.stop();

	17
	    }

	18
	}


6.  Compile, link, and upload the program.  Then place the robot onto the obstacle course (if needed) and test.

[image: image82.emf]
	1
	import lejos.nxt.*;

	2
	class xxSonar

	3
	{public static void main(String [] args) throws InterruptedException

	4
	  {UltrasonicSensor sonic = new UltrasonicSensor(SensorPort.S1);

	5

6

7

8

9

10
	
      while(sonic.getDistance() > 40)

        {

          Motor.C.setSpeed(900);

          Motor.B.setSpeed(900);

          Motor.C.forward();

          Motor.B.forward();

	11

12

13
	        }

      Motor.C.backward();

      Motor.B.backward();

	14

15

16
	      Thread.sleep (1000);

      Motor.C.stop();

      Motor.B.stop();

	17
	    }

	18
	}
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Forward until Dark Light Sensor
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3. Install a downward pointing reflective light sensor, on your NXT.  For Instructions:

a. Start the Program "Robotics Engineering Vol I", from the Robotics Engineering start menu folder.

b. Click the "Reference" Button at the top.

c. Click "Building Instructions" on the left, under "Reference".

d. Click "Front Light Sensor".

e. Follow the instructions for installing the sensor by stepping through the numbered steps, at the top of the page. 

4. Open the view.java program from the s:/robotics folder.
5. Save the view.java program on your Z:\ drive.  If you do not, the compile step will fail, because you do not have permissions to write the view.class file onto the S:\ drive
6. Compile, link and download the program to your NXT Robot.

7. Start running the "view" program on your NXT.
8. Select "Sensors"

9. Select Item 1 – Sensors
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10. Select Reflected Light Sensor (Floodlight)

11. Specify which port you plugged the light sensor into.
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Now let's write some code to use the light sensor.

3. Open Textpad

4. Write a new program, naming it xxForwardDark (where xx is your initials)
	1
	import lejos.nxt.*;

	2
	

	3

4
	class xxForwardDark

{ public static void main(String [] args) throws InterruptedException






	4

5

6
	  {final LightSensor light = new LightSensor(SensorPort.S1);




 


	7

7

8
	      while(light.readValue() > 40)

        {

          Motor.C.setSpeed(450);

          Motor.B.setSpeed(450);

          Motor.C.forward();

          Motor.B.forward();

	9

13

14
	        }

      Motor.C.stop();

      Motor.B.stop();

	15

16
	

	17
	    }

	18

19
	}
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Line Tracking Basic Lesson
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Now let's write some code.

1. Open Textpad

2. Write  a new program, similar to the ForwardDark light sensor program.

3. Name the class "LineFollow" and save the file as xxLineFollow.java (where xx is your initials)
	1
	import lejos.nxt.*;

	2
	

	3
	class xxLineFollow

	4

5

6
	{public static void main(String [] args) throws InterruptedException
  {final LightSensor light = new LightSensor(SensorPort.S1);



	7

7

8

9

10
	      while(light.readValue() < 45)

        {

          Motor.C.setSpeed(720);

          Motor.B.setSpeed(0);

          Motor.C.forward();

	11
	        }



	
	[image: image95.emf]


	12

13

14

15

16

17

18
	      while(light.readValue() >= 45) 

        {

          Motor.C.setSpeed(0);

          Motor.B.setSpeed(720);

          Motor.B.forward();

        }

   }

	19
	}




[image: image96.emf]
12. Create a while() loop around your existing code.  Position the curly braces so that both of the other while loop behaviors are inside this new loop.  For this new while loop's condition, specify "true".  This will create a loop which will never end.
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Now we’ll modify the line track program to continue the two behaviors inside an infinite loop.

1. Open the LineFollow.java program.

2. Make the following changes:
	1
	import lejos.nxt.*;

	2
	class xxLineFollow

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6
	  {final LightSensor light = new LightSensor(SensorPort.S1);


      while (true)

      {

	7

7

8

9

10
	        while(light.readValue() < 45)

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

	11
	          }

	12
	

	13

14

15

16

17

18

19

20
	        while(light.readValue() >= 45) 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450);

            Motor.B.forward();

          }

      }

   }

	21
	}
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Line Tracking – Better Algorithm
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2. Change the name of the class to match the name of the file you just saved it as.


3. Change the program to add a touch sensor object:

	1
	import lejos.nxt.*;

	2
	class xxLineFollow2

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);

      while (true)

      {

	7

7

8

9

10
	        while(light.readValue() < 45)

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

	11
	          }

	12
	

	13

14

15

16

17

18

19

20
	        while(light.readValue() >= 45) 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450);

            Motor.B.forward();

          }

      }

   }

	21
	}
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5. Replace the forever condition (true) with the condition “the touch sensor is unpressed”, the same condition you used to “run until pressed” in the Wall Detection (Touch) lesson.  
	1
	import lejos.nxt.*;

	2
	class xxLineFollow2

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);

      while (touch.isPressed() == false)

      {

	7

7

8

9

10
	        while(light.readValue() < 45)

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

	11
	          }

	12
	

	13

14

15

16

17

18

19

20
	        while(light.readValue() >= 45) 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450);

            Motor.B.forward();

          }

      }

   }

	21
	}




Compile, Link and Upload the program to your robot.
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	1
	import lejos.nxt.*;

	2
	class xxLineFollow2

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);


      while (touch.isPressed() == false)

      {

	7

7

8

9

10


	        while(light.readValue() < 45)

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

	11
	          }

	12
	

	13

14

15

16

17

18

19

20
	        while(light.readValue() >= 45) 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450);

            Motor.B.forward();

          }

      }

   }

	21
	}
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	1
	import lejos.nxt.*;

	2
	class xxLineFollow2

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);


      while (touch.isPressed() == false) 

      {

	7

7

8

9

10


	        while(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();
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	import lejos.nxt.*;

	class xxLineFollow2

	{public static void main(String [] args) throws InterruptedException

	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);

      while (touch.isPressed() == false) 

      {

	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450);

            Motor.B.forward();

          }

      }

   }

}
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	import lejos.nxt.*;

	class xxLineFollow2

	{public static void main(String [] args) throws InterruptedException

	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);

      while (touch.isPressed() == false) 

      {

	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450);

            Motor.B.forward();

          }

      }

      Motor.C.stop();

      Motor.B.stop();

   }

}


[image: image111.emf]
Line Tracking  Timer Lesson
The behavior we programmed in the previous lesson is great for those situations where you want the robot to follow a line straight into a wall, and stop.  However, let's see if there are any good ways to make the robot line track until something else happens.

To make the robot go straight for 3 seconds, we gave it motor commands, followed by a Thread.sleep(3000) command.  How would this work with line tracking?
	import lejos.nxt.*;

	class xxLineFollow2

	{public static void main(String [] args) throws InterruptedException

	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);



      while (touch.isPressed() == false) 

      {

	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }


        Thread.sleep(3000);

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450); 

            Motor.B.forward();

          }

      }

      Motor.C.stop();

      Motor.B.stop();

   }

}


Which one of the above locations is the right place to put the Thread.sleep command?

The correct answer is:  none.  There is no right place to put a Thread.sleep command to get the robot to line track for 3 seconds.  Thread.sleep does not mean "continue the last behavior for this many milliseconds,"  it means, "go do sleep for this many milliseconds."

You've really told the robot to put its foot on the gas pedal, and go to sleep.  That doesn't work when the robot needs to watch the road.  Instead, we'll keep the robot awake and attentive, using a Timer (rather than just Time) to decide when to stop.

Line Tracking  Timer (cont).
Java comes with a "Stopwatch" class.  We can create as many Stopwatch objects as we need.  Using these Stopwatches is pretty straightforward:  

First you create a stopwatch object with the following command:

Stopwatch stwatch = new Stopwatch();

where "stwatch" is the name we assigned to the object.

Then you reset the stopwatch (set it to zero) and start it running, with the following method:

stwatch.reset();

where "stwatch" is the name we assigned the object, up above.

You can look at the stopwatch, to find out how much time (in milliseconds) has elapsed since it was reset by using it's "elapsed" method:

stwatch.elapsed()



Line Tracking  Timer (cont).

1. Open the Touch Sensor Line Tracking program "xxLineFollow2".
2. Save this program under a new name, "xxLineTrackTimer".  (Note the "r" at the end of "timer".)

3. Rename the class to "xxLineTrackTimer".


	1
	import lejos.nxt.*;

	2
	class xxLineTrackTimer

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6

7
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);

      while (touch.isPressed() == false) 

      {

	8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24
	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450); 

            Motor.B.forward();

          }

      }

      Motor.C.stop();

      Motor.B.stop();

   }

}


4. Modify the program to use the Stopwatch class.

	1
	import lejos.nxt.*;

	2
	class xxLineTrackTimer

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6

7

8

9

10
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);


   final Stopwatch stwatch = new Stopwatch();

   stwatch.reset();


      while (stwatch.elapsed() < 3000) 

      {

	11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27
	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450); 

            Motor.B.forward();

          }

      }

      Motor.C.stop();

      Motor.B.stop();

   }

}
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Line Tracking - Rotation
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	1
	import lejos.nxt.*;

	2
	class xxLineFollow

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6
	  {final LightSensor light = new LightSensor(SensorPort.S1);

      while (true)

      {

	7

8

9

10

11
	        while(light.readValue() < 45)

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

	12
	          }

	13

14

15

16

17

18

19

20
	        while(light.readValue() >= 45) 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450);

            Motor.B.forward();

          }

      }

   }

	21
	}
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	8

9

10

11

12

13

14

15

16

17

18

19
	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450); 

            Motor.B.forward();

          }


	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6

7

8

9
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final Stopwatch stwatch = new Stopwatch();

   stwatch.reset();


      while (stwatch.elapsed() < 3000) 

      {

	10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26
	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450); 

            Motor.B.forward();

          }

      }

      Motor.C.stop();

      Motor.B.stop();

   }

}
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1. Start by opening the "xxLineTrackTimer" program.
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Line Tracking  Rotation (cont).
2. Save this program under a new name "xxLineTrackRotation".
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3. Change the name of the class to match the name of the file you just saved it as.
(xxLineTrackRotation).
	1
	import lejos.nxt.*;

	2
	class xxLineTrackRotation


[image: image121.emf]
	1
	import lejos.nxt.*;

	2
	class xxLineTrackRotation

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6

7

8

9

10
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);

   final Stopwatch stwatch = new Stopwatch();

   stwatch.reset();

      while (stwatch.elapsed() < 3000) 

      {

	11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27
	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450); 

            Motor.B.forward();

          }

      }

      Motor.C.stop();

      Motor.B.stop();

   }

}


Line Tracking  Rotation (cont).
It's time to start changing the program to use the Rotation sensors.  Rotation sensors have no guaranteed starting position, so, you must first reset the rotation sensor count.  It will take the place of the equivalent reset code used for the Timer.

The Motor class has a method to reset the tachometer count for a motor, it looks like this:


	1
	import lejos.nxt.*;

	2
	class xxLineTrackRotation

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6

7

8

9

10

11
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);


     //  reset tachometer for both motors to zero

      Motor.B.resetTachoCount();

      Motor.C.resetTachoCount();


      while (stwatch.elapsed() < 3000) 

      {

	12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27
	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450); 

            Motor.B.forward();

          }

      }

      Motor.C.stop();

      Motor.B.stop();

   }

}


Line Tracking  Rotation (cont).
The NXT motor Tachometer measures the motor rotation in degrees, so ti will count 360 for every full rotation the motor makes.  Change the while() loop's condition to make this loop run while the " Motor.C.getTachoCount" method returns a value of is less than 1800 degrees, five full rotations.

	1
	import lejos.nxt.*;

	2
	class xxLineTrackRotation

	3
	{public static void main(String [] args) throws InterruptedException

	4

5

6

7

8

9

10

11
	  {final LightSensor light = new LightSensor(SensorPort.S1);

   final TouchSensor touch = new TouchSensor(SensorPort.S2);

     //  reset tachometer for both motors to zero

      Motor.B.resetTachoCount();

      Motor.C.resetTachoCount();


      while (Motor.C.getTachoCount() < 1800) 

      {

	12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27
	        if(light.readValue() < 45) 

          {

            Motor.C.setSpeed(450);

            Motor.B.setSpeed(0);

            Motor.C.forward();

          }

        else 

          {

            Motor.C.setSpeed(0);

            Motor.B.setSpeed(450); 

            Motor.B.forward();

          }

      }

      Motor.C.stop();

      Motor.B.stop();

   }

}


Line Tracking  Rotation (cont).
We only checked one wheel and not the other.  Add a check for the other motor's tachometer (or rotation counter) to the condition.  The (condition) will now be satisfied and loop as long as BOTH motors remain below the distance threshold of 1800 degrees.

	7

8

9

10

11
	     //  reset tachometer for both motors to zero

      Motor.B.resetTachoCount();

      Motor.C.resetTachoCount();

      while (Motor.C.getTachoCount() < 1800 

             && Motor.B.getTachoCount() < 1800) 

      {
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Robots can Hear! -  Sound Sensor
 [image: image123.emf]
To install a sound sensor, on your NXT, use the Robotics Engineering Program:

a. Start the Program "Robotics Engineering Vol I", from the Robotics Engineering start menu folder.

b. Click the "Reference" Button at the top.

c. Click "Building Instructions" on the left, under "Reference".

d. Click "Sound Sensor".

e. Follow the instructions for installing the sensor by stepping through the numbered steps, at the top of the page. 

Robots can Hear! -  Sound Sensor (cont.)
Now let's write some code to use the sound sensor.

5. Open Textpad

6. Write a new program, naming it xxSoundLevel (where xx is your initials)
	1
	import lejos.nxt.*;

	2
	

	3

4
	class xxSoundLevel

{ public static void main(String [] args) throws InterruptedException






	5


	  {SoundSensor sound = new SoundSensor(SensorPort.S3);




 


	6

7

9

10
	   while (!Button.ESCAPE.isPressed())

     {

       LCD.drawInt(sound.readValue(), 3, 7, 4);

       


       LCD.refresh();

       

       Thread.sleep(100);



	11


	     }

	
	


	12
	 }

	
13
	}


Robots can Hear! -  Sound Sensor (cont.)

	1
	import lejos.nxt.*;

	2
	

	3

4
	class xxSoundLevel

{ public static void main(String [] args) throws InterruptedException

	5
	  {SoundSensor sound = new SoundSensor(SensorPort.S3);

	6

7

8

9

10

11

12

13

14

15
	        // loop until gray button is pressed on the NXT

   while (!Button.ESCAPE.isPressed())

     {

        // place the sound on the screen, 3 positions, at 7,4

       LCD.drawInt(sound.readValue(), 3, 7, 4);

        // refresh the screen putting the sound value on it

       LCD.refresh();

        // wait one tenth of a second before repeating loop

       Thread.sleep(100);

	16

17
	     }

	18
	

	19
	 }

	20

21
	}


End of Section:
Compile your program, link it, download it and run it.

Your robot's display should show numerical values… indicating the level of sound it can hear.

Make some noises, claps, etc., to see the impact on the sound levels the robot can hear.

Establishing a Sound Threshhold – Thresholds 301
If we want the robot to react to sounds, we need to establish a threshold.  Values above the threshold will be considered loud, by the robot, values below the threshold would be considered quiet.

To establish the sound threshold, we’ll use the same approach we did with the light sensor.

1.  Run the xxSoundLevel program just finished.  
2. Make some loud clapping noises, monitor the sound level displayed on the NXT’s screen.


3. Make note of the highest sound level displayed.  Example:  45

4. With only room noise, make note of the high end of normal room noises.  Example: 25

5. Find the average of the two numbers you recorded.  Example:  (45+25)/2 = 70/2 = 35

6. The sound threshold we can use, to differentiate between quiet and noise, would be 35.

Now we will write a program that performs an action, based on sound levels.  For this program, we’ll start the robot running, and we’ll want the robot to stop when it hears a clapping sound.

Start with the xxSoundLevel program, from above.

1.  Save the program as xxSoundStop

2. Change the class name to xxSoundStop

3.   Make the following changes:

	1
	import lejos.nxt.*;

	2
	

	3

4
	class xxSoundStop

{ public static void main(String [] args) throws InterruptedException

	5
	  {SoundSensor sound = new SoundSensor(SensorPort.S3);


	6





7


8

9

10

11

12

13

14

15
16
17
18

19
	        // loop until Sound is heard





   while (sound.readValue() < 50 )


     {

        // place the sound on the screen, 3 positions, at 7,4

       LCD.drawInt(sound.readValue(), 3, 7, 4);

        // refresh the screen putting the sound value on it

       LCD.refresh();

        // wait one tenth of a second before repeating loop

       Thread.sleep(100);

       Motor.C.setSpeed(450);

       Motor.B.setSpeed(450);

       Motor.C.forward();

       Motor.B.forward();





	20

21
	     }

	22

23
	  Motor.C.stop();

  Motor.B.stop();

	24
	 }

	25

26
	}


Compile, Link and Upload the program to your robot.

Test it… your robot should run until it hears a noise which exceeds the threshold you calculated.
Appendix A:  Install Lejos Firmware on your robot
You will need:

1. Your NXT (Robot)
2. A computer with leJOS NXJ installed

3. A USB connector cable

4. Prepare your pc

a. In Textpad, click Configure, Preferences.click Tools, at the bottom.  In the upper right hand corner, click “Add” and select “Program”.  Browse to:  Computer, C:, lejos06, bin, select nxjflash, click “Open”.  

b. Click “Apply”.

c. In the left side of the window, click the “+” next to “tools”, then click on NXJFLASH.

d. Blank out the “Parameters” box.  In the Initial Folder box type:  c:\lejos06\bin
5.  Set your NXT brick in update mode

To download new firmware, it is neccesary to set your NXT brick in Update mode. To do this you have to push reset button.  The button is on the back of the NXT, in the upper left corner.  Push it for for more than 5 seconds and you should hear an audible sound.
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6. Attach your NXT to the PC by its USB cable, you should see a message which indicates your NXT is attached in firmware update mode.
7. In Textpad, click “Tools”, nxjflash to flash the leJOS NXJ firmware. You will see some messages on your command window, and the NXT should show the leJOS splash screen and then the leJOS menu. 

nxjflash will write the Java VM and the leJOS NXJ start-up menu to the flash memory of your NXT. It will create an empty user flash area. When the flash procedure has finished, leJOS NXJ will start up and an empty menu will be displayed. 

You can switch the NXT off at any time, including when a program is running, by pressing the orange and dark gray buttons (ENTER + ESCAPE) together.To switch it back on just press the orange button. The leJOS NXJ start-up menu will be displayed. 

If your NXT freezes at any time, remove and re-insert a battery.

Appendix B:  Java Conventions

Java naming conventions:

Variable Names: Can start with a letter, ‘$’ (dollar symbol), or ‘_’ (underscore); cannot start with a number; cannot be a reserved word.

Method Names: Verbs or verb phrases with first letter in lowercase, and the first letter of subsequent words capitalized; cannot be reserved words.  Example: setColor()
Class And Interface Names: Descriptive names that begin with a capital letter, by convention; cannot be a reserved word.

Constant Names: They are in capitals.  Example: Font.BOLD, Font.ITALIC
Java reserved words:

	abstract
	default
	if
	package
	this

	boolean
	do
	implements
	private
	throw

	Break
	double
	import
	protected
	throws

	Byte
	else
	instanceof
	public
	transient

	case
	extends
	int
	return
	null

	Try
	Const
	for
	new
	switch

	continue
	while
	goto
	synchronized
	super

	Catch
	final
	interface
	short
	void

	char
	finally
	long
	static
	volatile

	class
	float
	native
	
	


Data Types

The most frequently used data types in Java variable declarations are listed here:

	Data Type
	Description
	Example

	Char
	A single character
	'a'

	String
	Any number of characters
	"my String"

	int
	An integer number from -2.14 billion to +2.14 billion
	1015

	float
	A floating-point number, with a decimal point
	3.14159265f

	boolean
	A logical value of either true or false
	true

	double
	Double precision rational number.  Covers a range from 4.94e-324d to 1.79e+308d (positive or negative)
	15.735


Variable Declaration

To create, or declare variables use the following syntax:

<datatype>   <variable name>

Example:   int numRotations;

Variable Initialization:

<datatype>  <variable name> = value

Example:   float pi = 3.1419f;

Constants

A variable can be declared as a "constant" to prevent its value from accidently being changed.  By convention we name constants with all uppercase characters – to distinguish them from regular variables.

Examples:

final float PI = 3.14159265f;

final int TOUCHDOWN = 6;

final int FIELDGOAL = 3;

Statement Delimiter
Like periods in an English sentence, semicolons mark the end of every JAVA statement.  Even though spaces and new lines are ignored by Java, and by the NXT, our convention it to write each statement on its own line to make it easier for human programmers to read.  Statements are run in “reading” order, left to right, top to bottom, and each statement is run as soon as the previous one is complete. When there are no more statements, the program will end.

Example:

final float PI = 3.14159265f;

final float WHEELDIAMETER = 5.4f;

float wheelCircumference = PI * WHEELDIAMETER;

Note:  the equal sign, is an assignment operator.  You use it to assign a value to a variable.

JAVA uses far more punctuation than English. Punctuation in programming languages is usually used to separate important areas of code from each other. Most JAVA punctuation comes in pairs.

Punctuation pairs, like the parentheses in these two statements, are used to mark off special areas of code. Every punctuation pair consists of an “opening” punctuation mark and a “closing” punctuation mark. The punctuation pair designates the area between them as having special meaning to the command that they are part of.
Motor.C.forward();
Thread.sleep(3000);
Simple statements do the work in JAVA, but Control Structures do the thinking. These are pieces of code that control the flow of the program’s commands, rather than issue direct orders to the robot.

Simple statements can only run one after another in order, but control statements allow the program to choose the order that statements are run. For instance, they may choose between two different groups of statements and only run one of them, or sometimes they might repeat a group of statements over and over.
One important structure is the task main. Every JAVA program includes a special section called task main. This control structure determines what code the robot will run as part of the main program.
public static void main(String [] args) throws InterruptedException

{    Motor.C.forward();

     Thread.sleep(3000);

     Motor.C.stop();

}
Control structure: main method
The control structure “static main” directs the program to the main body of the code. When you press “Start” or “Run” on the class you created, on the robot, the program immediately goes to task main and runs its code.

The left and right curly braces { } belong to the task main structure. They surround the commands which will be run in the program.
Checkpoint

Control structures like the main method decide which lines of code are run, and when. They control the “flow” of your program, and are vital to your robot’s ability to make decisions and respond intelligently to its environment.
Java Comments:

// Used for commenting a single line

/* ————— */ Used for commenting a block of code
Flow Control:

1. If……..else statements
Syntax:

if(condition)

{

statements;

}

else

{

statements;

}

2. For loop
Syntax:

for(initialization; condition; increment)

{

statements;

}

3. While loop
Syntax:

while(condition)

{

statements;

}

4. Do….While loop
Syntax:

do

{

statements;

}

while(condition);
A condition is made up of an expression which evaluates to true or false.  Comparison operators can be used

	Operator
	Comparison
	Example
	Description

	= =
	Equality
	a= =b
	a equal to b

	!=
	Inequality
	a!=b
	a not equal b

	>
	Greater Than
	a>b
	a greater than b

	>=
	Greater than, or equal to
	a>=b
	a greater than or equal to b

	<
	Less Than
	a>b
	a less than b

	<=
	Less than or equal to 
	a<=b
	a less than or equal to b


To combine multiple logical expressions use:

	Operator
	Description
	Example
	Description

	&&
	Logical AND
	a<b && a>c
	a less than b AND
a greater than c

	||
	Logical OR
	a<b || b>c
	a less than b OR 
b greater than c

	!
	Logical NOT
	a!=15
	a not equal 15


5a.   Save program As...�Select File > Save As... to save your program under a new name.





5d.  Make sure the type "java" is still selected.





5b. Browse to an appropriate folder


Browse to or create a folder (on your z:\ drive.) that you will use to store your programs.





5c. Rename program


Give this program the name “Hello”





Substitute your initials for xx.  �EXAMPLE:  fhTurnWheel.java





Compile


Select Tools > Nxjc to compile program.





Link


If your compile completed normally, Select Tools > Nxjclink to create a load module.





 Upload to NXT


Make sure your program is selected, Select Tools > Nxjupload to upload the program to your NXT.





Problem:


Drive safely through a field which may contain obstacles


Solution:


Move towards the destination, making small detours if any obstacles are detected





Labyrinth Robot


Problem:


Get through the maze��


Solution:


Move along a predetermined path in timed segments











Thinking About Programming Programmer & Machine





Robots are made to perform useful tasks. Each one is designed to solve a specific problem, in a specific way.





In this lesson, you will learn about the roles of the programmer and the robot, and how the two need to work together in order to accomplish their goals.





Robotic Tractor
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Role of the Robot





Problem 	Create plan	 Write program	Follow program 	Goal Reached





Problem	Create plan	Follow plan	Goal Reached











The human and the robot can accomplish the task together by dividing up the responsibilities. The human programmer must come up with the plan and communicate it to the robot, and the robot must follow the plan.





Thinking about Programming Programmer & Machine (cont.)





Because humans and machines don’t normally speak the same language, a special language must be used to translate the necessary instructions from human to robot. There are many such languages, with leJOS NXT  being one of them. These human-to-robot languages are called “programming” languages, and instructions written in them are called “programs”.





Human





Human





Robot





Robot





The machine is responsible for following the instructions it is given, and thereby carrying out the plan.





Basic or Simple Behavior


Some behaviors are small, like “go forward for 3 seconds.” Big behaviors are actually made up of these smaller ones.





As you begin the task of programming, you should also begin thinking about the robot’s actions in terms of behaviors. Recall that as programmer, your primary responsibilities are:


First, to formulate a plan for the robot to reach the goal,


And then, to translate that plan into a program that the robot can follow.





The plan will simply be the sequence of behaviors that the robot needs to follow, and the program will just be those behaviors translated into the programming language.





“Behaviors” are a very convenient way to talk about what the robot is doing, and what it must do. Moving forward, stopping, turning, looking for an obstacle... these are all behaviors.





Complex Behavior


Some behaviors are big, like “solve the maze.”





In this lesson, you will learn how thinking in terms of “behaviors” can help you to see the logic behind your robot’s actions, and break a big plan down into practical parts.
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Thinking About Programming Planning & Behaviors


























1. Examine problem


To find a solution, start by examining the problem.


Here, the problem is to get from the starting point (1) to the goal (2).





Thinking about Programming Planning & Behaviors (cont.)
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Break solution into smaller behaviors Now, start trying to break that behavior down into smaller parts.





Write them down as well, taking care to keep them in the correct sequence.





Break into even smaller pieces If you then break down these behaviors into even smaller pieces, you’ll get smaller and smaller behaviors, with more and more detail. Keep track of them as you go.





2. Broad solution


Try to see what the robot needs to do, at a high level, to accomplish the goal.





Eventually, you’ll reach commands that you can express directly in the programming language.


For example, leJOS has a command to turn on one motor. When you reach a behavior that says to turn on one motor, you can stop breaking it down, because it’s now ready to translate.





Following this path involves moving forward, then turning, then moving forward for a different distance, then turning the other way, and so on. Each of these smaller actions is also a behavior.





Having the robot follow the path shown on the left, for example, would solve the problem.


You’ve just identified the first behavior you need! Write it down.











Thinking about Programming Planning & Behaviors (cont.)





Large behavior	Smaller behaviors	leJOS-ready behaviors





Step by step


Start with a large- scale behavior that solves the problem.


Break it down into smaller pieces. Then break the smaller pieces down as well.


Repeat until you have behaviors that are small enough for LEJOS to understand.





Turn on left motor


Turn on right motor


Wait 3 seconds


Turn off left motor


Turn off right motor


Reverse left motor


Turn on right motor


Wait 0.8 seconds


Turn off left motor


Turn off right motor


Turn on left motor


Turn on right motor


Wait 5 seconds


...





When all the pieces have reached a level of detail that leJOS can work with – like the ones in the “leJOS-ready behaviors” list above – take a look at the list you’ve made. These behaviors, in the order and way that you’ve specified them, represent the plan that the robot needs to follow in order to accomplish the goal.


Because the steps are still written in English, they should be relatively easy to understand for the human programmer.


As the programmer becomes more experienced, the organization of the behaviors in English will start to include important techniques from the programming language itself, like if-else statements and loops. This hybrid language, halfway between English and the programming language, is called pseudocode, and is an important tool in helping to keep larger programs understandable.





Turn on left motor


Turn on right motor


Wait 3 seconds


Turn off left motor


Turn off right motor





Simple pseudocode


Your list of behaviors to perform in a specific order are a simple form of pseudocode.





if (the light sensor sees light)


{


turn on left motor


hold right motor still


}





Later pseudocode


As your programming skills grow, your pseudocode will include more complex logic, but will still serve the same purpose: to help you find and express the necessary robot behaviors in simple English.





brings in the objects which interact with the NXT robot, from the lejos libraries stored on your pc.


Note:  All statements in Java end with a semicolon.





Line 2 is blank.  Java ignores blank lines.  We put them into our programs to make them easier to read.





Gives a name to the program, or "class".  By convention class names start with a capital letter.  


Note:  The file name has to match this EXACTLY.  �Example:  XXTurnWheel.java 





These Brackets mark the beginning and end of the "class"





This code makes up the entire class, or program.  It is explained on the next page.





Every class can be made up of one or more methods.  One of the methods must be named "main".  The "main" method is the method where the computer starts execution.





These Brackets mark the beginning and end of the "main" method





This seemingly complex line is the standard Java way to define the starting point of all Java programs.  





The program declares a method named "main" that contain the actual commands of the program, within its curly brackets.





The keywords "public static void" precede the name of the method to define how the method may be used.  


public – this keyword determines how visible an item will be to other classes.  "public" means that other methods can see it.  In this case "main" is a method.  The main method of a class always needs to be declared "public".


static - this keyword ensures that the method is globally accessible from any other method in the class.


void -	this indicates that the main method does not return anything.  If the method returned something, we would specify the datatype of the returned value.  Example:  string.  Main methods do not return anything.





Inside the parenthesis, after the name of the method "main", we declare the datatype of the parameters passed to the method, then the name of the parameter.  In this case, the Operating System will be passing a string array, named "args" (the square brackets indicate an array).





This clause is required whenever we use the "Thread.sleep" method.





In this lesson, you will modify the existing program code to create a Moving Forward  behavior with the robot.








You should name every program starting with your initials, so that when it is downloaded onto the robot, you will be able to identify your programs, versus programs downloaded by others.





1b.  Make sure the type "java" is still selected.





1b. Browse to an appropriate folder


Browse to or create a folder (on your z:\ drive.) that you will use to store your programs.





1c. Rename program


Give this program the new name “TTLabyrinth” --- substitute your initials, instead of Tony Tiger's initials.





1a.   Save program As...�Select File > Save As... to save your program under a new name.





2. Add these blank lines


This is where we will add the commands for the second motor in the next step.





3. Add these lines


These lines are exactly the same as the lines above them, except that they are  directed at Motor B (right wheel) instead of Motor C (left wheel).





4a. Check connection


Ensure that your robot is turned on


and plugged into the computer


through the USB cable








4b. Compile


Select Tools > Nxjc to compile program.





4c. Link


If your compile completed normally, Select Tools > Nxjclink to create a load module.





4d. Upload to NXT


Make sure your program is selected, Select Tools > Nxjupload to upload the program to your NXT.





1. Modify this code


Change the 3000 milliseconds in the Thread.sleep methods to 2000 milliseconds





2.  Modify this code


Change the old 900 (100% power) to 450 (50% power) to make the robot move at half power. Do this for both motor commands.





3a. Check connection


Ensure that your robot is turned on


and plugged into the computer


through the USB cable








3b. Compile


Select Tools > Nxjc to compile program.





3c. Link


If your compile completed normally, Select Tools > Nxjclink to create a load module.





3d. Upload to NXT


Make sure your program is selected, Select Tools > Nxjupload to upload the program to your NXT.





1. Modify this code


Change the 2000 milliseconds in the Thread.sleep methods to 4000 milliseconds





2.  Modify this code


Change both motors to run at negative 900 degrees per second (-100% power).





3a. Check connection


Ensure that your robot is turned on


and plugged into the computer


through the USB cable








3b. Compile


Select Tools > Nxjc to compile program.





3c. Link


If your compile completed normally, Select Tools > Nxjclink to create a load module.





3d. Upload to NXT


Make sure your program is selected, Select Tools > Nxjupload to upload the program to your NXT.





Modify this code


Change the code to use the "backward" method…. don't forget to change the speed back to a positive number.





Modify this code


Change both motors to run at zero degrees per second.  Reset the backward methods to forward, though either will work.





Modify this code


Change the motors to run at 100% power in opposite directions.





Modify this code


Make one wheel move while the other holds its position.





6a. Modify this code


Restore the first behavior to a half-power forward movement.





6b. Add this code


Adding a left-point-turn behavior after the moving-forward behavior will make the robot move then turn.





The turn needs only about 0.8 seconds (800ms) to complete.





This is the part of our code which changes.








The rest stays the same for different distances and turns.





End of main method





Where to add our own methods


When adding our own methods, insert them inside the class "TTLabryinth.  Put them after the end of the main method, before the end of the class





End of TTLabryinth class





Method names start with lower case.  Upper case any embedded words.





The method needs to be seen by the rest of the program, therefore it is “public”.


It will not return a value, therefore its return type is “void”.


Its name is “moveRobot”


Its three integer (int) input parameters are speedB (speed of motor B), speedA (motor A), and runtime the duration of the run (int).





Since it will be using the Thread.sleep method, we need to include the declaration:  throws InterruptedException





All methods must have their code enclosed in curly brackets, this curly bracket is the beginning.  Notice how we try to line it up under the start of the method declaration.





Substitute the parameters speedC, SpeedB and runtime





End the method with a curly bracket.  Notice how we try to line it up under the opening bracket





Remove these lines and call our new method instead.





Calling the method we wrote two times:


1.  Move straight, 450 dps, 4 seconds.


2.  pivot trun, 450 dps, .8 seconds.





Note:  All java statements end with a semicolon, even calls to our own methods.





We can delete these blank lines.





Add “Math.abs(“ before “speedC” and “)” after.





Add “Math.abs(“ before “speedB” and “)” after.





Test the value of “SpeedC”, to see if its positive (greater than zero)





statements to run when the condition is true





statements to run when the condition is NOT true





The wheel diameter for a robot, and its gear ratio are usually constant.  We can declare them as global constants, here, before our "main" method.





Our new method, which will move the robot based on the requested distance, instead of time, will go here.





These are the names we are assigning to the constants.  For constants, by convention, name them with all capital letters.





double – this is a double precision, real number.





values for the variables





static - this keyword ensures that the variable is globally accessible from any other method in the class.


final -	this indicates that the variables value is constant, and will not change.





private


This indicates that this variable is only available within the MoveForward class… not outside of it.





method name:  goDistance


parameters:  �cmDistance - Distance desired, in centimeters, double precision


dpsSpeed – Desired motor speed in degrees per second, integer





First calculate the amount of time we want the motors to run, based on the distance we want to travel and the motor speed, using the formula from above.





(int) is a function which changes the number to its right into an integer format





Declare a new variable named msTime (time in milliseconds) as an integer





constants declared in the class





Now that we know the time, utilize the moveRobot method we've already written.





Build the Touch Sensor attachment


Building instructions are available on your computer, through the "Robotics Engineering Vol I" program on your computer.





Whenever we are using sensors, we need to declare an object, related to the sensor we are using.  For touch sensors use "TouchSensor" as follows:





The 1 indicates that this sensor is plugged into port 1.  Make sure you use the correct number corresponding to the port you plugged the light sensor into.





name of the object:


"touch"





While loop�The isPressed method will turn true when the touch sensor is depressed.  This loop will run as long as "isPressed" is false… as long as the touch sensor is not activated.





Statements we want to run as long as the condition is true are placed inside these brackets.





When the loop ends (the "isPressed" method became true), the robot ran into something.  Go backwards for a second.





End of main method





End of xxTouch class











      while(touch.isPressed(false)


        {


          Motor.C.setSpeed(900);


          Motor.B.setSpeed(900);


          Motor.C.forward();


          Motor.B.forward();


        }�
�
�
�






the isPressed value of the touch sensor is false











      while(touch. isPressed () == false)


        {


          Motor.C.setSpeed(900);


          Motor.B.setSpeed(900);


          Motor.C.forward();


          Motor.B.forward();


        }�
�
�
�






Build the Touch Sensor attachment


Building instructions are available on your computer, through the "Robotics Engineering Vol I" program on your computer.


Start the Program "Robotics Engineering Vol. I", from the Robotics Engineering start menu folder.


Click the "Reference" Button at the top.


Click "Building Instructions" on the left, under "Reference".


Click "Ultrasonic Sensor".


Follow the instructions for installing the sensor by stepping through the numbered steps, at the top of the page.





Declare a sonic Sensor Object


Replace the TouchSensor object with a UltrasonicSensor object using this new line.





The 1 indicates that this sensor is plugged into port 1.  Make sure you use the correct number corresponding to the port you plugged the ultrasonic sensor into.





Object name


The object can be named anything you wish, we'll call it "sonic" to remind us that it is a sonic sensor.





while


The keyword while indicates the beginning of the while loop.





The (condition)


As long as the (condition) is satisfied, the loop will continue to repeating.





Make this change


Change the (condition) part of the while loop





The (condition)


We want the robot to repeat the loop as long as the distance is greater than 25 cm..





(light.readValue() > 40)





Whenever we are using sensors, we need to declare an object, related to the sensor we are using.  For light sensors use "LightSensor" as follows:





The 1 indicates that this sensor is plugged into port 1.  Make sure you use the correct number corresponding to the port you plugged the light sensor into.





name of the object:


"light"





Modify this code�Change the while() loop condition’s value so that it will check whether the Light Sensor’s value is greater than the threshold value you calculated in the last lesson.  





Statements we want to run as long as the condition is true are placed inside these brackets.





When the loop ends (the light sensors value is 40, or lower), the robot has reached the black line.  Stop.





End of main method





End of ForwardDark class





Add this code.


The condition of this while loop will always be true, so the loop will run forever.





Indent


To make the program easier to read, move all of these lines over two spaces, because they are inside of the while (true) loop.





Add this code.


This curly bracket marks the end of the while loop we added above.





xxLineFollow2





Change Class Name.


The name of the class should be xxLineFollow2, where xx represents your initials.





Add this code.


We need to add a touch sensor object to the LineFollow2 program





Note the sensor port.


Since the light sensor is already using port 1, we’ll use port 2 for the touch sensor





�





Stopwatch Tips





Stopwatches should be reset when you are ready to start counting / timing.





The "elapsed" method represents the amount of time in milliseconds since the last reset.  It is shown here being used to make a while loop run until 5 seconds have elapsed.





stwatch.reset();





while (stwatch.elapsed() < 5000)





In this lesson you will learn how to use the Stopwatch class to make a line-tracking behavior run for a set amount of time.





4a. Add two lines here


4a.1  Create the stopwatch object


4a.2 reset


Resets the timer to zero and starts the stopwatch running.





This code is placed just before the code which starts the loop running.





4c. Modify this line


Base the decision about whether to continue running on how much time has elapsed since the stopwatch was reset.





compile error - If you receive the an error stating that it cannot find symbol, symbol  : class Stopwatch





You need to copy Stopwatch.java file from the s:\robotics folder into the same folder as the program you are trying to compile.





1a. Open Program





Select "File" then "Open" to retrieve your old program





1b. Select the Program





Click on xxLineTrackTimer.java





Example:


Motor.B.resetTachoCount();





Modify This Code





Instead of resetting a timer, reset the rotation sensor for each Motor to zero.  





These three lines replace the two lines which created a stop watch object, and reset it to zero.





Modify This Code





Set  Motor C to run for five full rotations, or 1800 degrees.





Add This Code





This change sets the condition to run while Motor C's rotation sensor reads less than 1800 degrees AND Motor B's rotation sensor also reads less than 1800 degrees 





NOTE:  && means AND – both conditions must be true for the while statement to continue execution





Whenever we are using sensors, we need to declare an object, related to the sensor we are using.  For Sound sensors use "SoundSensor" as follows:





The 3 indicates that this sensor is plugged into port 3.  Make sure you use the correct number corresponding to the port you plugged the sound sensor into.





name of the object:


"sound"





A new condition… this code will cause the loop to run as long as the escape button (the gray button) on the NXT has not been pressed.  The exclamation point represents "NOT".





Statements we want to run as long as the condition is true are placed inside these brackets.





This method draws an integer value (the sound level) on the Robot's display, using a 3 digit number, 7 places out from the left, 4 down from the top (x, y).





Wait one tenth of a second, before repeating the statements in the while loop (update the display with a new sound value)





The "refresh" method will update the LCD screen, on the NXT, to display the value just placed on it, by drawint.





End of main method





End of ForwardDark class





Change the comment





Change the condition.  Note:  Instead of 45, use the sound threshold you calculated





Add commands, inside the while loop, to make the robot move forward.





When the loop ends (the sound sensor value exceeded the threshold), the robot heard a loud sound.  Stop.
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